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Editorial 

This will be the last newsletter that I edit whilst working full-time. I am taking 

early retirement after over 28 years as a civil servant and looking forward to 

more time to spend on family history. I will report back in the next newsletter 

(I hope in the first half of September) whether I have actually made any 

progress on that front, together with the final programme for the PUG AGM 

and annual meeting in Oxford on Saturday12 November.  

 

This newsletter is a bit thinner and with some non-Pedigree articles but I hope 

will still be of interest.  Derrick Porter has come up with a way to search 

electronically for articles in old issues of the newsletter (page 10). Malcolm is 

investigating whether the old newsletters can now be put on PUGweb but in 

the meantime you may like to read about how it was done. Dick Walker (page 

5) and Mike Fisher (page 4) have provided some useful suggestions for your 

family history research. 

 

Please keep the articles coming – or at least suggestions for articles. One topic 

which has cropped up from time to time has been the use of small portable 

devices to carry information to record offices. As netbooks and tablets get 

smaller and lighter, this may be less of an issue but I wondered whether any 

one had tried loading PediTree generated PDF trees on to their Kindle or other 

e-Reader?  

 

Given that it looks as if there is still a demand for the newsletter, I aim to 

produce about 3 newsletters a year providing there is enough material to be 

worth doing. As we are continuing to publish the newsletter and organise the 

annual meeting, the Committee has decided that we should collect a 

subscription of £5 (£6 for overseas members) this year so please don’t throw 

away the address wrapper with the renewal form inside. 

 

Enjoy the summer. 

 

Hanna Nicholas 

London, June 2011 
 

Newsletter Contributions 

 

All contributions gratefully received, preferably by email. Articles of any 

length are welcome, as are photos for the page 3 feature which is still missing 

from this edition. Please let me have contributions by 31 August 2011 to 

editor@pugweb.org.uk  
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Chairman’s Corner 

Oh, the chairman has been cornered again, please write a piece for the 

newsletter ... 

 

Well, the first thing to report is that we have a newsletter, thank you Hanna. 

Hanna initially agreed, last year, to put something together at least once per 

year to include formal notice of the AGM. Well, she is clearly doing very 

much better than once per year, a result for which I'm sure we are all grateful. 

 

That said, Hanna has rightly pointed out that, without Rod's PUG-L digests, 

there would be very little meat to go inside this year's renewal form. If you 

want the newsletter to continue, please supply Hanna with things to print. 

Thanks go to Dick & Derrick for their input to this issue. 

 

Once again the AGM is going to be held in Oxford. Please can you all give 

thoughts to where we might hold the AGM if we should, for whatever reason, 

cease to be able to hold it at Oxford University Computing Services. This year 

we will be gathering on Saturday 12th November and several ideas for talks 

are being pursued by the committee, suggestions from you for AGM topics 

are, of course, always welcome. 

 

The committee are all continuing to do their job, keeping track of you (Carys), 

keeping track of our funds (Bob), digesting PUG-L & telling people about us 

(Rod), providing you with some arm-chair reading (Hanna) and trying to make 

minutes out of hundreds of emails (Clare). Meanwhile the chairman is not 

quite sitting back just occasionally calling the others to order, there are things 

progressing almost out of sight. 

 

PUGwiki has (especially with considerable work by Colin) developed apace - 

the various utilities are now obtainable from PUGwiki as are Murray’s latest 

two updates. In the course of the summer (i.e. on a slightly vague timescale) I 

will be working towards closing down the current and old versions of the PUG 

web site so that everything is reached through the wiki which will then be 

rebranded as PUGweb. That’s all boring stuff really, unless you like messing 

with PHP and CSS :-) 

 

A more exciting development is that I have (barely) started to put all the 

published PUG-L extracts (and the as-yet-unpublished ones eventually!) into 

the wiki so they can be more readily searched and, where appropriate, be 

updated in the light of experience. 

 

When you get as far as Derrick's piece on page 10, you'll see that we now have 

a complete set of past newsletter in PDF form, right back to David Hawgood's 

quill-scribed(*) first issue.  (* OK, so we have not been going quite that long!) 
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Derrick has agreed that we can make these available on CD for those attending 

the AGM this year but the committee has also agreed that we are not in a 

position to take on the selling and distributing of a CD in general - neither to 

members nor to Pedigree/Tree using non-members.   

 

Instead, I will be looking at the feasibility of making them available  from 

PUGweb. The largest file is 9Mb, the majority are 2-3Mb, so I think 

downloading should not be a big problem for most people. Before this can 

happen though, I have to work through the files removing the membership 

listings from them - that's another few evenings taken care of! 

 

Well, that's enough from me, do watch PUGweb/wiki and please do let me, or 

Clare, know if you plan to attend the AGM so I can make sure I have enough 

copies of the newsletter CD! 

 

Regards, Malcolm. 

       Malcolm Austen 

Chairman 

 

 

Your Homework for this Newsletter 
 

Go to the website  http://www.jaydax.co.uk/genlinks/census-records.html 

scroll down to ―more recent census‖ and print off or download the forms for 

the 1921/51/61/71/81/91 & 2001 census and with the aid of your relatives and 

whatever other sources you can find fill them in and add them to your           

database. It amazing how it gets the ―old uns‖ minds working.  

 

Shame my parents are dead (born 1915 and 1919) but my father-in-law born 

1920 can tell me about his family in the 1920s and you can use directories and 

electoral rolls to confirm addresses. 

 

Your descendants can compare your efforts with the actual returns. 

 

 

Mike Fisher, Droitwich 

my family tree http://mjfisher.tribalpages.com 
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These have collected over a long time so there is nothing very recent.  On the 

other hand there was something very old which came up at an AGM which 

some people did not know - Ctrl + Z to undo previous key stroke(s) in any 

Windows application.  So let's see if there is something that is new here for 

you. 

 

Keyboard Short Cuts 

When using the keyboard it can be useful not to have change to the mouse and 

quickly back again.  It is worth having a few often used short cut keys, but not 

too many so as to make them difficult to remember. 

 

Action Short Cut 

Copy Ctrl + C     

Cut  Ctrl + X 

Paste Ctrl + V 

Undo Ctrl + Z 

Cycle through open applications Alt + Tab 

Close an application   Alt + F4 

Cycle through open windows in an application Ctrl + Tab 

 (only starts in PediTree if no RIN is highlighted in the live list or the family 

window is live) 

Close an open window in an application    Ctrl + F4 

 (only works in PediTree if no RIN is highlighted in the live list or the family 

window is live) 

Open Explorer  Win + E 

Explorer list refresh  F5    

Highlight all  Ctrl + A 

Reveal Desktop Win + D 

Save    Alt + F then S 

Save As   Alt + F then A 

 

Put icons for each major DB in PediTree on Desktop, then Desktop shortcuts: 

   Target:   "c:\pedigree\peditree.exe c:\pedigree\Bloggs.ped" 

   Shortcut key: Ctrl + Alt + B 

   Icons: see PUGweb 

 

Internet Explorer 

If your browser automatically connects to a site when opened and refuses to let 

you do anything until you have waited for that site to load, click on Tools,    

Internet Options, General tab, Use Blank.  Mine used to insist on Google 

which I did not always want. 

Dick's Hints and Favourites 
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DBs, Scripts, Filters 

When you modify a DB, record what it was originally, what it is changed to 

and why you did it.  This allows you to undo it in the future or to put the same 

facility into a new DB version if one is issued.  Suitably laid out it can easily be 

used as a source for copy and paste.  The same sort of process allows easy 

reuse of successful filters.  It certainly reduces "What did I do ??" at a later 

date. 

 

Free Software 

I do not have a record of all the source of these programs so some may require 

Googling.  Some will have been found as a result of the "PUG Chairman's 

Choice". 

 

OpenOffice 

A program containing a suite of applications - word processor, spreadsheet,        

database, presentations, drawing.  The output can be saved in various formats     

including those of Microsoft.  No longer will you be unable to open received     

Microsoft documents without having the Microsoft application in the right          

incarnation.  My spreadsheet is Lotus 1-2-3 and it has no converters but I can 

open an Excel in OpenOffice and copy it into 1-2-3.   OpenOffice is my word 

processor and I save in .rtf then anyone can open it. 

(http://www.openoffice.org) 

 

Document Format Conversion 

Docxillion, particularly for .docx, from www.nchsoftware.com. 

 

Agent  Ransack 

A flexible search program which allows you to do what you want, unlike MS, 

and it has no childish little dogs. (http://www.mythicsoft.com/agentransack) 

 

ParLoc 

 A program which allows you to search for parishes, gives you their county and 

Chapman code and National Grid Reference.  It will tell you the distance 

between parishes in km or miles.  It plots a diagram illustrating the position of 

other parishes within a distance from a central parish, the latter two defined by 

you. (http://www.parloc.pwp.blueyonder.co.uk) [Ed: Malcolm points out 

that whilst this is downloadable, there are a few errors in the database which 

have been corrected online in the GENUKI church database http://

genuki.org.uk/big/churchdb/  ] 

 

KeePass 

Everybody demands you supply a password, often quite unnecessarily, and of 

course the proliferation is difficult to remember.  This little application allows  
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you to store your passwords with details of their use in one location protected  

by one master password.  (http://keepass.info/) [Ed: Malcolm points out that  
the original Keepass/L (linux) program seems to have spawned two free options for  

windows. Views welcome on their relative merits.] 

 

Calisto 

A program allowing conversion between calendars - Julian, Gregorian, 

Hebrew, Moslem.  It will also provide the day of the week for a given date. 

 (http://homepages.tesco.net/~jk.calisto/calisto/ ) 

 

Stripmail 

A program for removing the added ">" and bars found on forwarded email so 

that it can be pasted simply into some other document. Also useful for stripping 

the format off a document so you can do it again from scratch. (http://

www.stripmail.net/) 

 

Reasonably Priced Programs 

 

GenBox 

 A complete genealogy program but I only use it to produce some of my family 

trees having transferred the data by GEDCOM file.  The family tree plotting 

provides many options of style and allows movement of the boxes to suit your 

requirements. (www.genbox.com ) 

 

Omni Page 15 

This is a versatile OCR Program which will read paper documents or images 

and convert them into digital documents.  It works accurately on English, 

French and Italian documents and German, Spanish and other languages are 

included.  I am on the mailing list of Serif and this was a good offer.  I have 

received a number of good offers which has made the effort of deleting the 

many other offers worthwhile. [Ed: Carys notes that it is no longer owned by 

Serif, but Nuance. The current version is now 18 and costs £80.  Serif do still 

have free software, but bombard you with emails.]   

 

Value of the £  

This program will convert an amount of money at one date into its equivalent 

value at another date in the range 1600 to 1998.  It uses official inflation data 

and I have created a spreadsheet which extends is usefulness to the present.  

Purchased from Drake software associates. [Ed: or try the free currency 

calculator on the TNA website http://www.nationalarchives.gov.uk/

currency/  ] 
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Sources of information 

 

Diminutives of first names 

There is a useful list at http://www.nireland.com/anne.johnston/

diminutives.htm and  others are available. 

 

TLAs and FLAs 

Undefined acronyms are a curse but definitions can be found at http://

www.acronymfinder.com/ and there are other sites. (The above means Three 

Letter and Four Letter Acronyms :-)  ) 

 

PediTree versions 

Whilst I save all Murray's emails on updates I avoid the difficulty of finding the 

right one for the password by incorporating it in the file name eg 

pt3344robert.exe. 

 

Copying black and white documents for archive or email 

Scan the document at a reasonable dpi and print the obtained image file to file 

using PDF995 or similar.  The resulting pdf file is much smaller than the image 

file but has just as good definition and is easier to print or view. 

 

Dick Walker 

Date for diary 

The PUG AGM and annual meeting will be held on Saturday 12 November 

2011 at Oxford University Computing Services. (See Chairman’s Corner 

page 3-4 for more information). 

Reminders 

PUGweb is the website run by PUG on which you can find much useful 

information about Pedigree and PediTree, download software and generally 

keep up to date with developments and queries about the software. Details may 

be found at http://www.pugweb.org.uk  Also take a look at the new 

PUG wiki at http://wiki.pugweb.org.uk 
 

PUG-L is the email forum to which the majority of PUG members already 

belong. Full details about joining can be found on PUGweb. If you are still 

uncertain about how to do this, please contact one of the Committee (addresses 

and other contact details on the penultimate page).  The address is  

pug-l@pugweb.org.uk 
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News from Pedigree Software 

Version  3.334 was released in May 2011. This makes the following changes to 

the web output facility developed in January: 

Option to disguise names of living persons. 

Links on Person pages may now display further details when the cursor 

hovers over them. 

The bottom of Chart pages no longer overwritten when posted on the 

Rootsweb site. 

This version also resolves the occasional failure to obey option-settings on auto-

backup. 

 

Upgrading to PediTree.exe v3.334  costs £11 for CD or £10 just for a year of           

upgrades by web download. Although I can not accept debit/credit cards, if you 

email me with your choice of £10 or £11, I can get Paypal to invoice you and 

collect a card payment.  Cheques are still OK. 

 

Version 3 (pink) of the Getting Started Guide costs £2 and the newly revised 

version 2.3 (blue) of the User's Manual costs £7.  This is thanks to Colin 

Liebenrood who did the revision and all of the program updating to PediTree 

3.334. An alternative to the revised manual is a summary of Newsletter articles 

for islands, web output, CSV    import and date check is available for £1.50 or 4 

first class stamps  

 

The latest database for v3.332 onwards web output is Elton55.ped version 1101. 

This is  available from http://wiki.pugweb.org.uk/resources   That  version of 

the        Elton55 database is included in the updates to version 3.332-34  

 

Using Vista and Internet Explorer 9 I found that I had to override warnings that 

the program (Publisher unknown) could harm your computer.  I answered 'Run 

anyway'.  When saving the download I was not given the option to chose the 

folder so it used the Downloads folder from where you can run PT3334.exe and 

install PediTree to c:\pedigree 

 

Murray Kennedy 

Pedigree Software, The Granary, Ryelands, Wyre Piddle, PERSHORE WR10 

2JG 

Tel: 0(44) 1386 55 66 49 

murraykennedy@btinternet.com 

http://www.pedigree-software.co.uk/   

Update on PediTree 

file:///C:/Documents%20and%20Settings/HP_Owner/My%20Documents/PUG/2011%20newsletter/ptel61.htm#elt1101
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Background 

I started doing this some months ago for my own benefit.   I am surrounded by 

paper, literally, with shelves on about 50% of the walls in my room.  It could be 

more but I am reluctant to screen the windows in any way since the reason for 

my move to Australia three years ago was to get more light (I suffer rather badly 

from SAD).  

 

I suppose the stimulus came from organisation such as the Cambridgeshire FHS 

(Journals 1977-2004), the East of London FHS (the first 100 issues of Cockney 

Ancestor) and more particularly the GOONS (the first 100 issues of the Journal 

of One-Name Studies).  Three CDs have replaced several linear feet of paper. 

 

The over-riding benefit, however,  is not freeing shelf space but the ability to 

search rapidly, and to retrieve.  Hard disc space being virtually unlimited these 

days I have transferred the archival content of these CDs to one of my hard 

discs and use my own methods of searching and retrieval. 

 

I bought a small scanner a couple of years ago – a Fujitsu ScanSnap S510. I can 

load it with a sheaf of papers, press a button, and some time later have a file 

with images of all the pages which have also been OCRed on-the-fly.  Much of 

my day-to-day paperwork is now only in electronic format. 

 

As I said at the beginning, I started work on the PUG Newsletters some time 

ago, less for space-saving reasons but more for the ability it gives me to retrieve 

that vital bit of information that I vaguely remember reading a year or so ago.  

To be honest, I should probably say ―read yesterday‖ -  I have had my brain for 

more than 76 years now and its retrieval routines are starting to show signs of 

wear. 

Copying of the back numbers of the PUG Newsletter slowed down, somewhat, 

until I requested to receive my Newsletter electronically.  One thing led to 

another and Hanna sent me several copies of back-numbers in electronic format.  

This set me going again. 

What I have done 

1. The first thing to establish was the resolution of the scanning process.  

Low quality is rapid, but it doesn’t look very good, and the OCR process 

suffers.  I settled for a quality that gives a file size of 3-4 Mbytes per 

issue. 

Some comments on my production of a PUG  

Newsletter Archive 
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2. I am not sure when I joined PUG, but it certainly wasn’t from the 

beginning, so the scans of some of the early issues are made from 

photocopies of originals that were provided to me when I joined.  They 

are adequate, but if anyone can provided originals of the earliest 

newsletters it would be an improvement to the archive. 

3. I have stored  my PUG Newsletter in ring binders so punch holes are 

visible on some of the scans.  I have checked, and nothing essential is 

missing as far as I can tell. 

4. Some of the more recent Newsletter PDF files contained in the archive 

are from the pdf file sent to the printer and are not the result of a 

scanning process.  This means that (a) the quality of the image in very 

much better, (b) the indexing process is infallible since no OCR is 

involved and (c) the file is much smaller (e.g. Dec 2009 issue is 39 pages 

and 1,009 KB whereas the scanned Dec 2008 issue is 40 pages and 4328 

KB).  I am hoping to get more of these files from Rupert in due course. 

5. At present the following files are from printer’s originals:  15/1: Sep 

2006, 15/2: Dec 2006, 15/3: Mar 2007, 16/1: Dec 2007, 16/2: Mar 2008, 

16/3: Jun 2008, 18/1: Sep 2009, 18/2: Dec 2009 and 19/2: Feb 2011.  

6. The archive is contained in the only folder on the disc – PUG.  To access 

the archive, open PUG and click on index.html 

7. This leads to a menu system which simplifies browsing.  I have provided 

a brief Help-file (accessible via the Navigation menu) to assist searching 

of the complete archive – which is probably what most people will want 

to do. 

8. I use Adobe Acrobat 8. 

9. Searching is rapid, but it is faster if the archive is copied to a hard-disc. 

All suggestions, comments and requests for further information will be 

welcomed. 

Derrick Porter 

Queensland, Australia 

www.pluckrose.org 

derrick@pluckrose.org 
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Thanks once again to Rod who continues to compile these extracts; once again 

these are from 2005. The initials of the contributors to the original discussions 

are shown after each paragraph or item,  where this is clear, with full names at 

end of the subject.  As ever, there has been a little editing. 

 

GEDCOM export 
Can anyone tell me why it takes 95 seconds to do a GEDCOM export from my 

"small" database in PediTree and approx 3 seconds in Pedigree. 

My "large" database (c. 20,000 individuals) took about 10 seconds at 4 meg 

limit, it now takes 318 seconds (over 5 minutes) 

►MF 

I can't, at least not by that sort of amount! 

PediTree is slower than Pedigree, by a factor of about six on my system 

(WinXP 3GHz processor).  I tested GEDCOM 4 export of John Bloore's 

Peerage database (c. 30,000 individuals): Pedigree c. 6s; PediTree 29s. 

Was Mike's export GEDCOM 4 or GEDCOM 5.5? That might make a 

difference. 

►CL 

Following the latest email to the list I tried it again. I had made a few additions 

since my last export. I started a save to GEDCOM 4, thought I would leave it 

running in the background while I looked at other emails. As soon as I started 

in another window the computer went very slow and PediTree stopped 

processing. I open Windows Task Manager (alt/ctrl/del) and PediTree was "not 

running" and I had to end the program. 

I tried again with a save to GEDCOM 4 with task manager running, the 

processor was running at 100% and as I had added more information the time 

was 333 seconds. 

The database is 19475 person 4947 marriage, person.dat 5,861 KB, 

marriage.dat 698 KB and the GEDCOM size is 6,383 KB running v3.289. I 

have just done a GEDCOM 4 export of my early copy of Peerage (17,000 

person) it took 95 seconds WinXP 2.8GHz processor 768meg ram 

►MF 

I had noticed that PediTree export GEDCOM took longer, but have not been 

prompted to investigate it until now. When I find the cause then I'll let you 

know if it can be improved. 

►MK 

I have not found any excessive delays when running GEDCOM exports. I have 

windows 98SE and am using PediTree 3.289.  I have the following lists: 1438 

person; 374 marriage; 92 source; 203 census. I have just created both 

GEDCOM exports. The v4 took 2 seconds, as it usually does, and the v5.5 only 

took 3 seconds. 

►DA 

Extracts from PUG-L  
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Therefore, if it takes 2 seconds to export 1,500 people it should take 26 

seconds to export 20,000 but it took 319 seconds the last export and the CPU is 

running at 100% all that time! An import into an empty Elton55 took 203.75 

seconds without any indexes. An export from it took 140 seconds. The original 

database is 6.65 Meg and the loss of data importing it into Elton55 reduces this 

to 3.9 Meg, which is about half the amount and half the time.  What is the size 

of your database? My wife’s tree 0.43 Meg took 15 seconds so 4.3 Meg should 

take 150 seconds? 

►MF 

This is an assumption, isn't it Mike? I'm not aware that we know for sure that 

the time taken is a linear function of the database size. I would not consider it 

unreasonable if it worked out that doubling the database size meant the export 

took four times as long! 

►MA 

My Jelley dbase exports in 67 seconds (31000 person, 7000 sources, 18000 

marriages). 

►PB 

I have just exported it again 302 sec. Is there anyone with broadband willing 

try a GEDCOM export of my 6.63 Meg  x.pdm database on their copy of 

PediTree on their computer if I send it to them. At least I will know if it's the 

database or my computer. If it is my computer, then can anyone explain why? 

►MF 

Send it to me so that when Colin has tuned my GEDCOM export coding I can 

test it.  

I have just exported a 7.6 Mb .PDM DB in 88 seconds on XP 1.6Ghz PC. I 

assume that you were exporting to hard disc? 

►MK 

Just to let you know what's happening: My export 319 seconds. My wife's 

laptop 191 seconds. Richard Lloyd's 106 seconds. Murray 80 seconds. What 

should I do with my computer? With windows task manager monitoring the 

program PediTree took up about 90% of the CPU usage, which was running at 

100% and this time it, took 469 seconds. 

►MF 

How much memory do you have in there? 

► MK 

2.8 GHz 100% processor usage when running GEDCOM export, if I do 

anything else on the computer PediTree hangs up. 

►MF 

Suspect that something is wrong in the processor/memory area, I'm afraid, as it 

doesn't seem to do exactly what it says on the tin! Since PediTree is currently 

processor-intensive on this function, it is unlikely to be disk problems, 

although a full disk check would probably be a good idea.  I suspect that 

detailed information from the Task Manager might help the diagnosis, but I 
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don't have any knowledge of how to interpret it. The last time I had problems 

with a slow-running processor-intensive program was on another machine with 

too little physical memory. As a result, my program was working in paged 

memory, involving a lot of extra disk accesses.  With 768Mb of memory, that 

shouldn't be a problem.  Does Task Manager correctly show this amount of 

memory? 

►MK 

There is a small (39k) free program called Memtest86, which you can 

download - put the name into Google. You produce a form of boot-up floppy, 

which tests every bit of your memory, but does not actually boot up fully. I 

have used it when I had a problem, but it was not memory in the end. 

►MP 

Welcome back!  I've seen reports of unspecified problems with AVG 7, 

perhaps this is one of them? Don't bother to send your DB.  Murray has tested 

my revision of PediTree on it, which showed a x 5.5 speed-up (15s against 80s 

previously).  I've sent him a copy of your message, in case you hadn't told him. 

►CL 

Murray has sent me a copy of PediTree with the GEDCOM modification and 

another bug cure. It now takes 19-21 sec instead 320 sec. Well done. 

►MF 

(Mike Fisher; Colin Liebenrood; Murray Kennedy; David Anderson; Malcolm 

Austen; Patrick Black; Michael Pugh). 

Text in Text Fields 

 
I am now onto entering more source information. In Pedigree the "text" field in 

the source used a monospace font so when entering a census I could ditto the 

line above in the required places and it looked very neat. 

Now in PediTree I can't seem to get anything to line up. 

Is it possible to select a monospace font to correct this problem, or would it be 

possible to enable "tabs" in the "text" field? 

►MF 

It would be possible in the next version to add another option in the 

Print>Fonts dialogue to select a font for the text / notes editor, such as      

Courier (monospaced).  You might want to select it for the detail box too, but it 

would increase width in the panel.  For printing you would also need to  select 

a monospaced font when printing tables or reports for these text / notes fields. 

If I were to allow tabs to be used for alignment, it would not be GEDCOM 

compatible, nor work in Pedigree. 

►MK 

(Mike Fisher; Murray Kennedy). 
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 Error message on deleting 
I was in PediTree deleting a little surplus family of parents, marriage and 1 

son. I deleted the son, deleted the wife, deleted the marriage, and then the 

husband. At that point I got an error message: Family +DBgc HF.getL rt=0 

f=0 (if I read my handwriting correctly!) and the husband's name became 

"not male=" Things seem to work OK after this.  Any explanation? 

►RL 

Thanks for reporting it, with detail. I have not been able to trace the problem 

yet - or see why it should be reported. 

►MK 

I get the same problem while I am deleting parents when I have put the    

children into one family from the IGI download for my One Name Studies.  

The list I am working from also disappears after the person has been deleted 

from the family.  It is OK when deleted from the list but then one has to go 

back to delete the rest of the family . 

►SJ 

The error message was triggered when the family was redisplayed with the 

only remaining person having been deleted.  I now remove the family      

window without message.  I have removed from the diagnostics log the list 

of deleted records too. I have also added a warning if you try to delete the 

last spouse without removing the marriage first. The index is hidden after   

deleting a record because it is more difficult to remove deleted entries, which 

may or may not be visible before the deletions.  Perhaps I can improve that. 

►MK 

Thanks for locating a solution for this little problem. Regarding Sheila's 

vanishing List, I recall discussing this with you some time ago and 

understand the reason for the list being withdrawn is because it is now out of 

date. However, I wonder whether there is a possibility of recalling the list to 

the place where it was last referenced? Typically I think of the situation I've 

had quite a bit recently through converging two sets of data, where Fred 

Bloggs occurs twice in the Person list; I decide which one (and maybe his 

immediate family) have to be killed in the family window, but then have to re

-choose the person list and re-find the other Fred Bloggs. A quick way of 

reverting to the     person nearest to the last used name would be helpful - but 

I can see that with the original Fred dead, this could be a logically difficult 

operation. How about providing the means to open a list or a family at a 

marked record? Then providing one mark the living Fred, one can quickly 

revert to the appropriate place. I've sometimes felt that the Mark facility was 

underused, and perhaps this would be ideal for going back to the place in the 

family tree from which one has wandered off (beyond the reach of the step-

back button) 

►RL 
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What I can do easily is to allow a right click on the marked person in the 

toolbar to select them as current.  Then sliding the mouse to the left, you can 

select the icon to choose them in a family or list window.  A left click on 

marked person hides them. 

►MK 

Yes, that seems to provide an acceptable way of achieving what I had in mind; 

I must admit I'd tended to forget that the marked person is displayed up there. 

Would it be worthwhile putting the legend "Marked:" alongside him? 

Incidentally, I note that if I left click on him at present, he vanishes, and won't 

come back without re-marking him - perhaps with the new proposal, it would 

be better to disable this "facility", otherwise clumsy fingers will lose the return 

route to the wanted person. 

►RL    (Richard Lloyd; Murray Kennedy; Sheila Jelley). 

 

PediTree Error message 
I have gone back to December version of PediTree where you sorted me out 

with various errors on "Get Buffer etc, etc,." I copied the good clean version of 

Conduct.pdm onto an empty drive so I could experiment with it, and found that 

after deleting, for example, a duplicate name, and or "marking" and placing a 

name into the correct family, the problem of "Fatal Error, get Buffer: RIN 85 

inconsistent for Record type 1, RIN 9232, etc" arose. You so kindly sent the 

"EraseRIN" attachment, and after many attempts at using it and it not 

succeeding, it was decided to send you the data file. I have been trying to send 

you the compressed file of the error data, but after continuous endeavour, the 

server will NOT let me send 38xx Kbs (3.8Mgs) of attachments - it is too 

large. I have been pondering on this and wonder if a feature can be put into 

PediTree as a supplementary program to erase problems like this, for example 

a self fix  without all the fuss of sending back (or trying to) data to you, as you 

must be worked to the bone with stuff like this. I have copied Pugglers in case 

other people have the same problem. 

►BVC 

So far I have not reproduced the error on the DB after deleting and placing 

records. I will try to add a facility in PediTree to erase index references to 

records corrupted although it is only about 6 times a year that they are reported 

- as many from Pedigree as PediTree. I was testing your ConductM.pdm 

massive DB and found that Check DB failed to repair 17 links that it should 

have done in your first few MINs.  I have found a fault in the repair process 

that I have now fixed, and your DB is now 'Integrity OK'.  I can send this 

PediTree version but it will not get past your corrupt records.  If you send your 

DB on CDROM I can repair it as I may not get the above self repair facility 

working soon enough for you to erase them. 

►MK                                               (Brian Verdun Conduct; Murray Kennedy). 
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 Pedigree - character limit for definition/choice types in 

drop down lists? 
 

I have a field in my Pedigree Source records in which I enter the Chapman 

code of the source location.  It helps me sort out who's where. Because I don't 

know the American states off by heart, let alone the Australian, Canadian/NZ or 

Irish county/province names, I thought I'd make myself a drop-down list with 

them all in.  There are 210 codes altogether. Although I was able to paste the 

list into the Choice Types box in the Definitions menu, I wasn't able to save 

them before Pedigree closed down. Just wondering how many characters I'm 

allowed to put in that Choice Words box, please? 

►AC 

If you use PediTree to look up 'limits' in the online help, then you see, amongst 

others: 

50 Field types/file 

Dates between 100 AD and 2100 AD 

21 max characters in a date edit, e.g. bef. 11 Mar 1699/1700 

10 fields in a group 

15 letters in a field name 

8 choice types; Pedigree /PediTree have a limit of 17 different choice words 

(like M,F for sex) for each of the 8 choice types. 

So I do not think that a choice field is suitable. 

If you are using PediTree, and the field that you use for Source location is 

Source.place, then you already have a picklist facility. 

You can either fill the picklist yourself (which I think is your best option) or to 

let PediTree create it from all your place fields that are used more than once in 

events etc. To look at PediTree help, see the help index on Placename listing 

and then placename picklist.  (I will add picklist to the index now). 

Alternatively, use the List menu to choose Places list, right click and hover over 

Places picklist and press F1 for help. 

If you want to make your own list, then call it PLAC.LST in \Pedigree, and use 

the Window menu to select that plac.lst in PediTree. 

To use a picklist, in edit mode, right click on a place field that you are editing 

and select pick from list 

If your location is not Source.place then email me for specific advice on adding 

a new type of picklist, which can be done.  Note that Pedigree cannot use 

picklists. In that case, I would use Notepad alongside Pedigree to choose and 

copy a name. 

►MK 

(Ann Cossar; Murray Kennedy). 
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PediTree marriage entry problem 
Following my new years resolution I am using PediTree. I have come to enter 

my first marriage entry, actual details of a marriage not just the automatic 

creation of a marriage, I right click on the marriage in the family display and 

then on Edit. The display comes up, I open the edit grid and enter date, place & 

notes, F9, F9 on the family display I get then date and the notes, not the place. 

If I open the database with Pedigree, I just get the notes. I press "C" to edit the  

marriage and there is no date or place, just the notes. I check the database in 

PediTree- DB integrity good I check the database in Pedigree- a corrupt record 

must be erased. 

Do you want to continue? Y/N 

If I say Y it erases the marriage I have just entered. 

I re-enter the marriage again using PediTree, save as GEDCOM, open a new 

DB, import the GEDCOM. 

Close PediTree and open the new DB with Pedigree and open the marriage for    

editing. 

This time the date and place are there & the DB has "no errors" when 

"checked" 

I still do not get the place of the marriage on the family window. Any 

suggestions please? 

►MF 

I have been using PediTree to enter some Marriage event detail and lots of 

Person event detail recently and had one glitch when a place didn't appear on 

the main edit screen and had to go back to enter it again.  I couldn't reproduce 

the fault then or just now, but will look out for it. Thank you Mike for sending 

an example of a DB with this problem to enable me to cure it. 

For a long time there has been a possibility of this corruption occurring when 

pasting text or adding too much text to any text field, if you do not use the       

detailed text editor which has tabs along the top edge. 

Most text fields like education, places, and event.notes have a limit of 255    

characters.  When there are at least 20 characters in the field that is being 

edited, you can double click to use the detailed text editor that restricts you to 

255 (unless it is a Person.notes or Source.text or other long text field limited to 

4095 characters).  However, if you continue typing in the cell of the grid editor, 

or if you paste text into it, it is possible for PediTree to store too much for the           

database structure.  This is only detected by Pedigree's check DB function.  

From the feedback that I have received, this type of error seldom occurs. I will 

report later on what action users can perform to check their databases. This 

problem has been fixed in today's PediTree v3.290, which will be released 

shortly to users registered for email upgrades since 01 February 2004. 

►MK                                                                (Mike Fisher; Murray Kennedy). 
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 Sorting Event Places 
I am trying to sort birth events by birth.place to try and sort out the movement of 

families. I am sorting surname,birth.place,birth.date. 

The problem is it sorts from the wrong end of the place so does not group in 

country,county,parish,place 

Has anyone overcome this problem? 

►MF 

Not sure I can help you Michael but I appreciate the frustration. I chose to enter 

all my source info in county, parish, place order e.g. CHS, Daresbury, All Saints 

to get round this. However my person info is in conventional format for         

readability on printouts so I'd have the same problem. I await any bright ideas. 

►SJ          (Mike Fisher; Shirley John). 

 

Copying a multipart field 
My relatives seem to move very frequently so not only are there a lot of sections 

to fill in for one residence but there are frequently half a dozen residences. Is 

there an easy way of copying and pasting a doubly multipart field like Residence 

from husband to wife?  Even copying all the sections of one residence easily 

would be helpful. 

I presume there is also no way of easily copying information about censuses 

transferred into Sources from a pre-Elton database into the census fields apart 

from retyping most of it. 

►BO 

Copy & Paste should always be an easier (and less error-prone) option than  

retyping! 

►MA 

I hate to say it, but if you edit your database in Pedigree for MSDOS, in a     

window, not full screen, then you can use the Windows mark and copy to paste 

the fields from a single event, residence or occupation occurrence to another  

record that you then edit. 

If you have not used quick edit mode, then right click in the top blue window 

caption to choose Edit>Mark.  Select the residence.from date down to country in 

a rectangle, and right click the top to select Edit>Copy or just press Enter. 

Escape this edit and select the other Person such as the spouse. Position the    

cursor by keyboard on the residence.from and then Right click the top to choose 

Edit>Paste which will copy the fields down to country.  

In the Window menu, if you click properties you can select Quick Edit Mode 

which will mean that to Mark, you just drag the mouse over an area, right click 

to copy it and then in the destination field, right click will paste it - provided that 

you have moved the cursor by keyboard. There is no easy way of transferring as 

you describe. 
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If you have lots of 1881 censuses, then the easiest way is to get them again 

from CDROM, saving them as RTF, then using GEDutils to convert RTF to         

GEDCOM and import them.  You still have to connect the Source and Censuses 

to your Person records. 

For a few records that I had in other years, I left the Source alone, but created 

and attached to that Source, Census line records for the Person records that 

were important to me, by retyping or a bit of copy and paste from Source.text. 

►MK 

(Beryl Orchard; Malcolm Austen; Murray Kennedy). 

 

Memory? 
I run Windows XP - stacks of RAM - with Pedigree - the DOS version. Have 

made my database the Large variety. 

When working on data entry after a few uses of the F4 key to look at an          

individual I get a message either "Can't open temp file Disk full" press esc or 

"No memory for Doc: remove resident programs?" press esc.  I can use F4 in a 

person's record, but not to view the record as a whole.  By closing the program 

and re-opening I can use F4 again but after a few uses the messages return. 

How can I get round this problem.  I tried increasing the cache sizes in the      

options menu to no avail. Any suggestions would be appreciated. 

►RB 

I can't remember the causes of these types of error messages. I wonder if the 

database is corrupt? Try doing a GEDCOM export of the database, and if     

successful, make a New DB and import the GEDCOM to that.  Try the same 

actions again on the same records. If it still happens then I would think that 

there is a problem in your PC/XP, but you could send me the DB to try.  If it is 

OK than I assume that you have overcome the corruption.  If the GEDCOM  

export fails, send me a backup of the DB, not the GEDCOM. 

►MK 

One diagnostic check would be in Pedigree to look at Options > Memory left. 

On my XP system, this shows 14,667Kb with a Huge database loaded. Much 

less than this would suggest an XP set-up problem; but I'm not sure where that 

might be! 

►CL                            (Raymond Blight; Murray Kennedy; Colin Liebenrood). 

 

New Computer 
I have a new computer (XP) to replace my rather ancient one (95) and am about 

to install PediTree / Pedigree. I have the CD I bought last year with PediTree 

v3.272 on it. My question is - Can I bring this up to date with a single v3.290 

update now available? I then intend to copy my databases from backup floppy 

discs - or is there a better way? My old computer cannot write CDs. 

►MT 
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Yes. but you should have v3.286 in a perspex envelope from 10 Sep 2004. 

Since v3.272 there have been no other file changes other than those that you 

get with the web upgrade to v3.290.  PedSpecs Jan 2004 and Elton55 v402 can 

be downloaded from PUGweb. You ask ―I then intend to copy my databases 

from backup floppy discs—or is there a better way?‖  That is what I would do. 

►MK 

You are right. I do have v.3.286. It was tucked away out of sight. Many thanks 

for your response. 

►MT       (Mike Thomas; Murray Kennedy). 

 

Outputting Data 
I have a requirement to output details of individuals in either Word or Acrobat 

format to send to someone else who is also researching this family. They are 

not using a genealogy package so GEDCOM is out of the question. The            

individuals are all the descendants of one of my G G Grandparents – 60 in all.  

I have created a descendants list and have output a tall tree to Acrobat using the 

'Brief' profile.  I now want to output all of the details of each individual, 

because there are too many details to accommodate on the tall tree.  I right 

click on the    descendants chart and select the DrawReport option and then the 

Detailed tab.  I right click on the detail and select the Print All option which 

gives me a message saying 'This will print all of this list of 60'.  For the printer, 

I then select Acrobat PDFWriter, hoping to output the contents of the Detail 

Boxes for all 60 people on the list. The resultant PDF file is empty apart from a 

line saying Pnnnn deleted.  The Pnnnn looks like a RIN but is much higher 

than any RIN that I have in my   database. I cannot find a way of outputting all 

this text into a Word file, which would be my preferred medium because the 

text can then be cut and pasted. What am I doing wrong?  Grateful for any 

help, including 'If I was doing that, I wouldn't start from there' type of help.  I 

am using PediTree v3.288. 

►BB 

Trying this on version 3.290, I get an error from PediTree and no output. I 

think the problem is producing a Report from a Descendants Plan. 

Here's an alternative that works. 

1. Note the Plan letter of the Descendants Plan. Let's say it is B. 

2. Choose a List of all Person records. Right-click in it, and choose Filtered 

Search.  In the script editor that appears, type the script 

treeref contains "B" 

(using whatever letter you have in place of B). Click OK to get a new list of all 

the people in the Descendants Plan. 

3. Produce a Table from this list and choose the Detailed tab, which puts out 

the contents of the Detail Box for each person. 

4. You then have two choices: a) print to Acrobat (as before); b) save as RTF 
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and import the result into Word. I've tried the above (on a 73-person list 

produced as described) without problems: 10 pages of PDF for my data. 

►CL 

I agree with Colin. I have removed Print All from the Report popup menu if 

the list is a plan. That is because only the first (descendant) partner would be 

selected in the list report (if it worked as intended<g>), whereas the Person list 

filtered on treeref will include both partners. 

►MK    (Bob Brown; Colin Liebenrood; Murray Kennedy). 

 

"File size exceeded": advice to PUG members. 
Murray was of great help to me this morning and I thought that his simple 

advice may be useful to others, hence this note.  In creating a new source 

record in my ATHERTON database, I got a "File Size Exceeded.  Press 

Escape" message when I tried to save it with F10.The total size of this database 

was 1.3 MB and (using Alt+O/Definitions) I found that 1.021 MB of this was 

taken up by 385 Source records.I rang Murray who confirmed that the max 

size for each type of record was 1 MB. 

He explained how I could change to a "large" PDG database with 3 or 4 MB 

per record type, but if the database was unlikely to ever grow much more, I 

could probably achieve the extra space by doing a GEDCOM export of 

ATHERTON, creating a new database with a different name (I used ATHNEW) 

and doing a GEDCOM import from ATHERTON.  This compresses the         

database, which becomes fragmented after years of use.  

This was very easy, and I was pleased to see that the Source records had        

reduced in size from 1.021 to 0.685 MB, which gives me enough space for the 

foreseeable future.  

I also found that the Person and Marriage records had reduced from 171 to 

106, and from 14 to 13 K respectively.  The numbers of persons and marriages 

had "reduced" from 1080 to 1069 and from 325 to 320 because of deleted 

records (although I had of course remembered to export them as nulls when I 

did the GEDCOM export).  

A very interesting and useful thing is going on here.  In the old ATHERTON 

database, the unused rins do not appear in lists, but are included in the total 

numbers in Definitions.  Whereas in ATHNEW, the unused rins DO appear in 

lists but are NOT included in the total numbers.  This is very useful, because as 

it is now so easy to spot unused rins in lists, it will be very easy for me to use 

them for new people and marriages which should, I assume, minimise future 

fragmentation. 

I had to remind myself (by consulting my own "Idiots' Guides to Using Source 

Records to write Family Histories" articles in the PUG Newsletter a few years 

ago) that in generating the new indexes (see page 43 of Users' Guide v.3) it is 

necessary to define pictures for my Source indexes (using Alt-O/Pictures/
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Picture types/source/list).  I usually use "rin type refnum title" but only use    

refnum for descriptions of photographs so it is very easy to filter a list to give 

me a list of photographs only. 

Incidentally, I also like to add an initial "rin" field in the marriage list picture. 

I also reminded myself to say YES to Alt+O/Show RINs. 

Personally, I have stuck with DOS Pedigree, which works perfectly for me in 

XP, because it still does all I need, and is brilliant for sources and linking these 

to individuals and vice versa.  I put everything into Sources including census 

records.   

►RA 

 (Ralph Atherton). 

As you will have read elsewhere in the newsletter, we will be asking you to pay 

a subscription again for the 2011-2012 membership year starting in      

September. Amazingly, there is no price increase! The subscription remains at 

£5 for UK members and £6 for overseas members.  

 

Advance payments covering last year will now cover this next year instead. 

Please check the line above your address on the  renewal form. This shows 

when you have paid to; if it's anything other than August 2011, then no      

subscription is due. 

 

I realise it may seem indecently early to request a payment not due until 

August. However, it is only a fiver and if you do it now, you won't have to       

remember it later! 

 

I look forward to hearing from you all.  

 

Membership Changes 

 

New member 

 

Mr Tim Deakin, The Homestead, Rickinghall, Diss, Norfolk IP22 1DY T: 

07974 407883 E:t2dkn@btconnect.com 

 

I have been informed of the death of long-standing member Mr Thomas     

Fattorini. Our sympathies go to his family. 

Carys Faichney 

Membership Secretary 

 

Membership 
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